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Read Me First

Welcome to Take Control of Calendar Syncing and Sharing
with BusyCal, version 1.1, published in August 2013 by TidBITS
Publishing Inc. This book was written by Joe Kissell and edited
by Adam Engst.

This book explains the fundamentals of calendar syncing and
sharing in OS X and iOS in a simple, nontechnical way. It covers
the use of BusyCal 2.5 (and, where it’s useful for BusyCal users,
the Calendar app in OS X and iOS) with calendar-sharing services
such as iCloud, Google Calendar, and Office 365.

Copyright © 2013, alt concepts inc. All rights reserved.

Updates and More

You can access extras related to this ebook on the Web (use the link
in Ebook Extras, near the end; it’s available only to purchasers). On
the ebook’s Take Control Extras page, you can:

» Download any available new version of the ebook.

» Download various formats, including PDF, EPUB, and Mobipocket.
(Learn about reading this ebook on handheld devices at http://
www.takecontrolbooks.com/device-advice.)

* Read postings to the ebook’s blog. These may include new tips or
information, as well as links to author interviews. At the top of the
blog, you can also see any update plans for the ebook.

If you bought this ebook from the Take Control Web site, it has been
added to your account, where you can download it in other formats
and access any future updates. However, if you bought this ebook
elsewhere, you can add it to your account manually; see Ebook Extras.

Sponsored by BusyMac

This book was sponsored by BusyMac. Special thanks to
John Chaffee and Dave Riggle for their help, suggestions,
and support.
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Save 509% on Your Next Take Control Ebook Order!

Although this ebook is free (thanks to BusyMac!), most Take Control
ebooks cost $10-$15. The series covers Apple-related topics such as
0S X, i0S, iCloud, Apple Mail, iTunes, AirPort networking, backups,
and passwords, as well as various important independent apps.
Whether this is your first Take Control ebook or you’re a regular
customer, we’d like to invite you to save 50% on your next order—
click here to browse our catalog with the necessary coupon-
embedded link.

Add as many ebooks as you like to the cart and then confirm that
this coupon code—CPN21003BUSYCAL—has been applied on the first
screen of the cart. If the code doesn’t appear, for whatever reason,
be sure to enter it at the upper right of the first screen of the cart,
without any spaces before or after it.

Basics

Here are a few rules of the road that will help you read this ebook:

* Links: All blue text in this ebook is hot, meaning you can click
(or tap) it, just like a link on the Web. If you click a link to switch
to a different part of the ebook, you can return quickly to where
you were if your ebook reader offers a “back” feature. For example,
if you use iBooks in iOS to read the EPUB version of this ebook,
you can tap the “Back to” link at the lower left of the screen. Or, if
you use Preview on the Mac to read the PDF version of this ebook,
you can choose Go > Back or press Command-[.

* Menus: Where I describe choosing a command from a menu in
the menu bar, I use an abbreviated description that puts the name
of the menu ahead of the command. For example, at the end of the
previous paragraph, “Go > Back” means “choose the Back command
from the Go menu.”

* OS X names: I sometimes mention features specific to particular
versions of OS X, which Apple normally refers to by their names
rather than numbers—for example, Mavericks is OS X 10.9 and
Mountain Lion is OS X 10.8. To find out which version of OS X your
Mac is running, choose Apple @ > About This Mac.
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» Contextual menus: In OS X, when you hold down the Control
key and click, a pop-up contextual menu appears, with commands
appropriate to whatever is under the mouse pointer. Control-
clicking nearly always works to open a contextual menu, but your
mouse or trackpad might support a better method. The default
behavior, the alternative methods, and the ways to set them vary
depending on the type of input device; the typical alternative (for
right-handed users) is to right-click with a mouse—click the right-
hand mouse button—so that’s the term this book uses by default
for the action that opens a contextual menu.

What’s New in Version 1.1

Version 1.1 of this book covers BusyCal version 2.5, which adds support
for Exchange accounts (including Office 365). As a result, I've made
extensive changes throughout the book and added several new topics,
including Office 365 and Share Office 365 (Exchange) Calendars.



Introduction

Considering the variety of fantastically complicated tasks computers
can do with ease—converting spoken words to text, rendering 3D
animation, sequencing genomes, and so on—something as pedestrian
as keeping one’s calendar in sync among several devices should be
easy, right? How tough can it be to get a handful of dates, times, and
event details to be the same on multiple devices? This seems like the
sort of thing that should have become a non-issue about 20 years ago.

And yet, somehow, many of us still struggle daily to get appointments,
meetings, and tasks to show up the way we expect on our Macs,
iPhones, and other devices. The services that were supposed to make
this simpler, such as iCloud, Google Calendar, and Office 365, have

in some cases merely added layers of complexity. And if you share
calendars with other people or manage meetings for which you want
to track invitees’ availability, it gets even more confusing. It should all
Just Work, but too often, it Just Doesn’t.

Part of the problem is that companies providing calendar services—
Apple, Google, and Microsoft, I'm looking at you—have typically done
a poor job educating their users about what’s going on behind the
scenes and how to make wise decisions about calendar use. They tell
you what to do (click here, enter such-and-such an address in this
field) but not why.

The rather quixotic task I've agreed to undertake in this book is to
untangle this tricky business of calendar syncing and sharing in a

way that ordinary, nontechnical folk can easily grasp—and to do it in
about 50 pages. I've written this to help you understand and make the
most of a system that is, to be honest, kind of twisted and inconsistent.
I hope that by learning more about how calendar services and
applications work, you’ll become more comfortable and confident in
setting up, syncing, and sharing calendars.

You may already be familiar with the Calendar app that comes with
OS X (where it was formerly called iCal) and iOS. BusyCal 2, which I
focus on in this book, is a replacement for the Calendar app on OS X—
one I've used personally for years. It looks superficially similar to the
Calendar app and has many of the same features, but it’s easier to use,
more customizable, and more flexible than what Apple offers. In most
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cases (with a few exceptions that I discuss later), BusyCal and the
Calendar app can share the same data, which means you can switch
back and forth seamlessly if the need arises.

However, this book is not intended as a user guide for BusyCal. We
didn’t title this book Take Control of BusyCal, and for good reason:
BusyCal already has thorough instructions, which you can find at
http://www.busymac.com/help/. The online help already does an
excellent job of explaining how to do stuff in BusyCal. I focus on
explaining why things work the way they do (and what doesn’t work)
so you can make smart decisions about managing your calendars.

By the time you’re finished reading this short book, you should
understand the basics of how calendar servers and clients work,

when and why to use iCloud, Google Calendar, or an Exchange server
(including Office 365) for syncing and sharing, and how to construct
a sensible calendar strategy using BusyCal 2 on your Mac—even if you
also use other calendar apps or share calendars with people who do.
Along the way, I'll guide you gently but firmly toward practices that
will make your life easier and try to dissuade you from those that will
add unnecessary complication and pain.

BusyWho?

This book assumes you have BusyCal 2.5 or later (although it
mentions Apple’s Calendar app for OS X and iOS where appropriate).
BusyCal is a calendar app from BusyMac (http://www.busymac.com/)
that works in OS X 10.8 Mountain Lion or later. If you don’t already
have it, I highly recommend it because it eliminates many of the
irritations of Apple’s Calendar app and adds useful new features. It's
available from the Mac App Store (http://www.busymac.com/buy).

BusyCal is ideal for individuals, families, and small workgroups who
want to sync and share their calendars. And, with the support for
Exchange servers and other new features added in version 2.5, it's
even a great fit for most enterprise users, on par with Outlook’s
calendar capabilities.
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Calendar Syncing and
Sharing Quick Start

You may not need to read this entire book, but because later
chapters build on earlier ones, I recommend reading the book
in order and skipping any portion that doesn’t apply to you.
(For example, if you never share calendars over a local network
or invite people to meetings, there’s no need for you to read
the chapters about those topics.) In any case, please start with
Understand Calendar Basics, which lays the groundwork for
everything that follows.

Start on the right foot:

Get a grip on important concepts and terms; see Understand
Calendar Basics.

Sync and share your calendars:

Connect to calendars hosted on iCloud, Google Calendar,
Office 365, and other calendar servers with BusyCal on your
Mac; see Sync Calendars with the Cloud.

Give friends, family members, and colleagues read-only or read-
write access to your calendars; see Share Calendars with Other
People.

Find out if you're one of the few people who should be sharing
calendars over a local network instead of the cloud; see Share
Calendars over a Local Network.

Invite people to meetings, track responses, and deal with the
complexities of meeting invitations; see Manage Meetings.



Understand
Calendar Basics

We've come a long way since the days of manually syncing iCal

on our Macs with our PDAs using iSync. (Remember that? If not,
count yourself lucky. That was not a happy time.) But some old,
outdated concepts have stuck around in our collective unconscious,
while some new concepts haven’t quite taken hold. As a result,
many people have a mental picture of how calendars work that’s,
well, out of sync with reality!

In this chapter, I paint a new image for you that puts everything

in its proper place, without getting too technical. I start by defining
some terms and talking about how calendar clients and servers
interact (I go into more detail in the next chapter, Sync Calendars
with the Cloud). I end the chapter with guidance on developing
your own calendar strategy, with links to specific discussions later
in the book.

Get an Overview of Important Concepts

If you're like me, you will arrive at this section ready to skip it. “Hey,

I know what a calendar is! I don’t need to read a bunch of boring
definitions,” you may be thinking. Fair enough; I definitely don’t want
to bore you. But please stick with me for the next few pages, because
you may find a few surprising facts along with confirmations of things
you already knew or guessed.

Here are the crucial concepts I want to be sure you understand:

» Event: An event is any activity you want to keep track of that’s
associated with a date and/or time. In other words, event is a
generic term that can apply to anything you might put on your
calendar—a birthday, holiday, appointment, meeting, whatever.
Some events specify only a day, or a range of days, while others
are scheduled for a precise number of minutes or hours, and others
recur according to some pattern. But the fact that some date or
time comes into play is what separates events from tasks.
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* Meeting: A meeting is an event that involves multiple participants.
For the purpose of this book, however, we're only talking about
events to which you've electronically invited other people (or have
been invited by someone else) in such a way that each participant
can set their status (such as accepted or declined).

» Task (a.k.a. Reminder or To Do): A task is something you
want to keep track of that isn’t assigned to occur at a specific time.
(BusyCal refers to a task as a “to do,” while Apple uses the term
“reminder”—all three terms refer to the same thing, but I largely
stick with “task” to keep it generic.) A task might have no scheduled
time at all, or it might be assigned to a date but not a time.

Unlike all-day events such as holidays, which occur on a specific
date, tasks can carry forward on your calendar until the date that
you mark them as completed. That means if you create a task to
pick up the dry cleaning on Thursday and you don’t check it off,
it’'ll automatically carry forward on your calendar to Friday.

» Calendar: A calendar is essentially a collection of events, tasks,
or both. You might have a single calendar that contains all your
events or several different calendars (for example, one for personal
items, one for family items, and one for work items). Every calendar
can have a name and a color to help you identify its events in
BusyCal or Apple’s Calendar app.

» Server: A calendar server is a computer program that stores
calendars for any number of people and makes their data available
over a network (usually the Internet) using any of several standard
protocols, or methods of transferring data.

There are several kinds of calendar servers, including the widely
used Microsoft Exchange Server (which also powers the calendar,
contacts, and email portions of Office 365), and CalDAV, the most
common industry-standard calendar protocol (iCloud, Google,
Yahoo Calendar, and Fruux are all CalDAYV servers).

If you're interested in the nitty-gritty of how CalDAV works, or

are having trouble sleeping, you can read the details of the protocol
at http://caldav.calconnect.org/. The short version is this: CalDAV
extends WebDAV to be used for transferring data in iCalendar
format between clients and servers (where WebDAYV is a file-
transfer protocol based on HTTP—the protocol of Web servers—
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and iCalendar is a simple text-based format for event and task
information). You absolutely do not need to understand any of
that, but I thought you might be curious.

Client: A calendar client is a program (or app) that runs on

a computer or mobile device and connects to a calendar server.
The client is what displays your calendars on screen, lets you edit
them, and irritates you with all those alarms and pop-up windows
you forgot you requested. BusyCal and the Calendar app are both
clients for CalDAV and Exchange servers.

In most cases, a client keeps a complete copy of everything in the
server-based calendars you connect to, so that you can see and

use your calendars even when you'’re not online. In addition, most
clients also give you the option of storing calendars locally—that
is, right on the device you're using instead of on a server. (I'll have
more to say about local calendars in the chapter Share Calendars
over a Local Network.) For now, if you’re wondering where your
calendar lives, the most likely answer is that it is stored both on
the device you're using and on a server somewhere on the Internet.

The one and the many: A given client can connect to more
than one server at the same time. For example, BusyCal can
show iCloud calendars alongside Google calendars.

Cloud Sync: The overused and overhyped term “cloud” has,
appropriately enough, a rather nebulous definition. It’s often

used to mean something like “existing somewhere on the Internet.”
But that could be true of any server. Cloud services, such as
iCloud, Google Calendar, and Office 365, use many computers,

in geographically diverse places, to store and distribute data. That
way, even if a single server or router were to fail, there would still
be multiple paths between your client and the data you want to
connect to—it’s not just in one place, it’s in many. From the client’s
point of view, syncing a calendar to “the cloud” works exactly the
same way as syncing to a single CalDAV or Exchange server; the
only difference is the infrastructure used on the other end. As a
result, in this book I don’t generally distinguish between syncing
to a single server and syncing to the cloud.

Syncing involves the client and the server matching up their records
and making sure the most recently modified bits on either end are
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reflected on the other. Whenever an event changes, it gets a time
stamp, so the client and server usually have very brief conversations
about only those events for which the timestamps don’t already
match. I explain how to set up cloud sync in the next chapter, Sync
Calendars with the Cloud.

Fetch and Push: When the client asks the server if there have
been any recent changes, that’s called a fetch update. When the
server says to the client, “Hey, I've got some fresh new data for

you here!” that’s called a push update. Fetch updates can happen
on a fixed schedule (such as every 10 minutes) or manually; push
updates happen as soon as the data changes on the server. Several
different methods of push updates exist, but the details aren’t
important for this discussion. Suffice it to say that for push to work,
the server must support it, the client must have push turned on,
and there must be a live network connection between the two.

All things being equal, push is usually better than fetch because it
reduces the chances that the same piece of data will change in more
than one place in between syncs, which would result in a conflict.
However, please be aware of the following points:

» Not all calendar servers support push updates from server to
client. Notably, iCloud and Exchange 2010 or later (including
Office 365) do, but Google Calendar and Exchange 2007 do not.

» Notice how I said “from server to client” in the last point?
That’s key, because all clients, and all servers, regardless of
their settings, support push updates from the client to the server.
For example, if you update an event in BusyCal on your Google
Calendar, that change is sent to Google immediately, and if you
were to check the Google Web site, you would see it right away.
However, a client running on another device won'’t reflect that
change until its next scheduled (or manually initiated) fetch.

Sharing: You can make a calendar of your own available to other
users so that it syncs with their calendar clients too. In this book,
I generally use the term “sharing” for this activity, although it’s
sometimes referred to as delegation (see Work with Delegation,
later). For cloud-based calendars, the server handles the sharing.

LAN Sharing: When calendars are shared between Macs on
your Wi-Fi or Ethernet local area network (LAN) rather than
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over the Internet, that’s LAN sharing. BusyCal supports LAN
sharing, but Apple’s Calendar app doesn’t.

However, there’s more to LAN sharing than first meets the eye.
BusyCal doesn’t act as a CalDAV server on your local network;
instead, it uses a simpler publish-and-subscribe model. Any copy
of BusyCal on your network can act as a server, publishing one

or more calendars to make them available to other Macs, and any
copy of BusyCal can also act as a client, subscribing to calendars
published by other Macs on your network. Because any given
copy of BusyCal can simultaneously act as a server and a client,
this arrangement is sometimes called peer-to-peer networking.

With those crucial terms clarified, I want to expand a bit on the notion
of syncing calendars on a Mac or iOS device with a server.

Learn about Syncing with a Server

I started this chapter with a reference to the bad old days of calendar
syncing, in which your Mac held the master copy of your calendar and
had to be tediously synced from time to time, over a wired connection,
with your mobile devices. But those days are long gone, and I urge you
not to think about calendars that way anymore. If you learn just one
thing from this chapter, it should be the following;:

When you’re syncing calendars with a server, the server—not the
client—holds the master copy of your data.

In this respect, calendar servers and clients work much like the IMAP
servers and clients you probably use for email. The app running on
your Mac or i0S device has a copy of all your data, of course, but that’s
merely a reflection of what’s on the server. Making any change locally
immediately pushes that change up to the server, updating the master
copy. The changes can then propagate down from the master (via push
or fetch) to all the other devices that connect to the same account.

Because every change to your calendars, from any device, goes through
that central hub before flowing out to the other devices, your Mac
doesn’t sync directly to your iPhone, say, or another Mac. Instead,
everything syncs to the cloud independently. Your Mac isn’t the hub;
the server is.
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Just as you no longer sync two devices directly to each other, you

also don’t sync two servers to each other. Although it was once
possible to use BusyCal as a makeshift hub to republish an iCloud
calendar to Google Calendar (see the sidebar Farewell to Republishing,
next), it was never a very good idea and is no longer possible in
BusyCal 2. Don’t worry about Google Calendar and iCloud showing
you exactly the same calendars—madness lies that way. Instead of
trying to mirror calendars on completely different servers, simply
connect to each of the servers separately on each device.

I should mention, however, that not all servers are created equal.

Even though iCloud and Google Calendar both use CalDAV, their
capabilities don’t align precisely. Read Learn about the Major Calendar
Server Providers for more details on the differences.

Farewell to Republishing

If you used BusyCal 1.x, you may be aware that it had the capability
to take an iCloud calendar and republish it to Google Calendar, or to
republish an iCloud or Google calendar over your LAN. (If you weren’t
aware, you didn’t miss anything important. You can skip the rest of
this sidebar. Move along—nothing to see here.) That capability is
gone in BusyCal 2.

One reason republishing no longer exists is that it was inherently
fragile; because of the many variables involved in the process that
were beyond BusyCal’s control, republishing often didn’t work
reliably, and it led to considerable confusion and grief.

But a more important reason for the change is that it encouraged
unnecessarily complicated calendar setups. Letting each client
connect to each server independently is much more efficient. Since
BusyCal and the Calendar app can connect directly to iCloud, Google
Calendar, and Exchange servers at the same time, the biggest reason
to republish was to make your iCloud calendars available to yourself
on the Google Web site, so that if you were checking your calendars
in a browser, you could see them all in one place instead of going to
two different sites. It also enabled you to make calendars that were
stored on one cloud-based service available in another, for the benefit
of those who don’t have accounts with the service you use. Although
you lose those small conveniences in BusyCal 2, you gain a simpler
and more reliable setup.
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Develop a Calendar Strategy

Now that you have the basics of calendars and calendar syncing under
your belt, your next task is to develop a sensible calendar strategy for
yourself (and perhaps for your family or business). Let me begin by
laying out a few key suggestions that will make your life easier:

If possible, use only cloud-based calendars. Even though you can
create local calendars in BusyCal or the Calendar app that show

up only on the device you're using, doing so makes syncing difficult,
if not impossible.

Note: Because BusyCal 2 no longer supports OS X’s Sync Services
framework, /local calendars in BusyCal 2 don’t sync with Apple’s
Calendar app, or with iOS devices via iTunes. Similarly, local
calendars no longer sync to third-party apps that use Sync Services,
such as Microsoft Entourage or Outlook. Cloud-based calendars
continue to sync just fine!

As cloud services go, iCloud and Exchange offer more calendar
syncing features than Google Calendar (including support for
push sync, tasks, and attachments) and superior compatibility
with OS X and iOS devices. So, if you have the choice, go with
iCloud or Exchange—and between the two, iCloud is the better
choice for those who use Apple products exclusively. However...

While iCloud works better with Macs and iOS devices than Google
Calendar does, the opposite is true for Android devices.

Exchange is best for syncing and sharing with Windows Outlook
users in an enterprise setting.

Whichever cloud provider you choose, you’ll have the best results
by far if everyone in your family or organization uses the same one.

Similarly, even though both BusyCal and the OS X Calendar app
can connect to any calendar server, because BusyCal has features
not found in the Calendar app, you’ll have better results using
BusyCal on all the Macs that are connecting to the same calendar
server rather than mixing the Calendar app and BusyCal.
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Note: As long as you stick with cloud-based calendars, it's no
problem to switch back and forth between BusyCal and Apple’s
Calendar app.

In the remainder of the book, I help you answer the following
additional questions:

* Should I use iCloud, Google Calendar, or Office 365? See Learn
about the Major Calendar Server Providers.

* How do I go about syncing my Mac and iOS calendar apps to
whichever cloud service(s) I've chosen? See Connect to a Cloud-
based Calendar Server.

» I want other people to be able to use one or more of my calendars.
Should I be sharing them or syncing them? What’s the difference?
See Learn How Calendar Sharing Works.

» I've decided that sharing is what I need to do. How do I do that
with iCloud, Google Calendar, and Office 365? See Share iCloud
Calendars, Share Google Calendars, and Share Office 365
(Exchange) Calendars.

» What about those public calendars I've always subscribed to, such
as those with movie release dates or national holidays? See the
sidebar Public Calendar Subscriptions.

» Should I use LAN sharing? If so, how? See Share Calendars over a
Local Network.

» IfIneed to schedule meetings and manage attendees, what special
considerations should I keep in mind? See Manage Meetings.
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Sync Calendars with
the Cloud

Whether you use iCloud, Google Calendar, Exchange, or another
cloud-based service, the cloud can serve as a central repository

for your calendar data that all your devices can connect to. Syncing
calendars to the cloud offers many advantages, but each service

has certain idiosyncrasies you must contend with. In this chapter,

I explain the key features of major calendar services, how they differ
from each other, and how to connect to them from a Mac (using
BusyCal or Apple’s Calendar app) and an iOS device.

Before I go any further, I want to clarify that when I say “syncing”
here, I'm talking about syncing your own calendars between the
cloud and one or more Macs and iOS devices that you personally
use. If you want other people to be able to see what’s on your
calendar or you want to see what’s on theirs, those topics are
covered in the following two chapters, Share Calendars with Other
People and Share Calendars over a Local Network.

Learn about the Major Calendar
Server Providers

It’s not my purpose in this book to get into the minutiae of protocols
and standards, but since you’ll be using Apple’s Calendar app or
BusyCal to connect to one or more calendar servers, a few quick
words about CalDAV and Exchange are in order before moving on
to particular providers.

About CalDAV and Exchange

The CalDAYV standard specifies a way for clients and servers to
implement calendar services that should provide complete
interoperability. However, as with so many things in the computing
world, the devil is in the details. For one thing, although CalDAV
first saw the light of day in 2003 and was formalized as a standard in
2007, not every implementation of CalDAV is complete or up to date.
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In addition, the standard continues to evolve, as various groups
work together to extend and enhance CalDAV. In June 2012,
Scheduling Extensions to CalDAV achieved “RFC” (request for
comments) status from the Internet Engineering Task Force, which
essentially means the manner in which meetings should be handled
in CalDAYV has graduated from “strong suggestion” to “requirement.”

Why should any of this matter to you? Well, one might assume
that since CalDAYV is a well-defined standard, whatever is true for
one CalDAYV server or client is true for all of them. Alas, no such
luck. In particular, Apple’s implementation of CalDAV differs from
Google’s implementation, and both differ from what you'll get in
any of numerous other CalDAV servers (such as Yahoo Calendar
and Fruux). As a result, things that work with one provider won’t
necessarily work with another.

Furthermore, BusyCal takes advantage of several CalDAV features
that iCloud supports behind the scenes, but which Apple’s own
Calendar apps haven’t implemented. The result is that a piece of

data that syncs brilliantly between iCloud and several Macs running
BusyCal may not show up at all in the Calendar app, or may even

be deleted if you modify an event in the Calendar app that you created
in BusyCal. (I say more about this ahead, in the iCloud discussion.)

Microsoft’s Exchange Server handles not only calendars but also
contacts and email. It’s been around since 1993, and since Microsoft
made all the decisions about its capabilities, it evolved more quickly
than CalDAV. However, that’s a mixed blessing. Numerous versions

of Exchange Server are in widespread use, and not all of them have the
same features. For example, Exchange Server 2010 and 2013 support
push notifications, but Exchange Server 2007 doesn’t. Unfortunately,
it’s often difficult for ordinary users to tell which version of Exchange
Server they’re connecting to. Furthermore, several third-party calendar
providers use their own implementations of Microsoft’s Exchange
protocols, which introduce still more variables.

Of the many CalDAV and Exchange calendar server providers,
however, a few major players stand out, especially for Mac users.
Here are some facts you should know about them.
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iCloud

Apple’s free iCloud service (http://www.apple.com/icloud) offers
push synchronization of calendars (including tasks), contacts, notes,
and Safari bookmarks; an email account; document syncing for
selected OS X and iOS apps; and a variety of other useful features.
You can access most of your data, including your calendars, in a Web
browser, or using client software included with every Mac and iOS
device (as well as with BusyCal and other third-party apps).

Tip: If you want to learn all the ins and outs of iCloud, allow me to
recommend my book Take Control of iCloud.

iCloud uses a fairly modern and complete implementation of CalDAYV,
and is constantly being updated and improved to support the latest
standards (unlike Google Calendar). BusyCal is optimized for use with
iCloud, as it supports syncing both events and tasks, as well as other
data types unique to BusyCal, such as graphics and tags.

Unlike Google Apps, iCloud offers no way for you to use its services
with your own domain name. One implication of this is that if you're
using iCloud for your calendars and you send out meeting invitations,
they may not come from your preferred business email address. (See
Where Meeting Invitations Come From for more about this confusing
situation.)

In iCloud (as well as in OS X 10.8 or later and iOS), calendars and task
lists are treated as separate entities—you use the Calendar app on your
Mac, iOS device, or the iCloud Web site, to view and edit events, while
using a different app, Reminders, to manage your tasks. (You can read
Apple’s description of this bifurcation at http://support.apple.com/kb/
HT4969.) BusyCal, on the other hand, shows you both events and
tasks (or to do items) in the same window, which was also the case in
iCal (as the Calendar app was called prior to Mountain Lion).

Note: Some calendar servers still combine events and tasks on

the same calendar, but the trend is shifting toward splitting them.
BusyCal is compatible with both types of calendar servers—those
that combine events and tasks on the same calendar and those that
require events and tasks to be stored on different calendars.
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The BusyMac Web site helpfully lists other iCloud quirks (for details,
read http://www.busymac.com/tc/caldav-limitations.html), but

I'm happy to say BusyCal 2 overcomes most of the iCloud-related
limitations earlier versions had. All things considered, iCloud is a fine
(not to mention free) choice for hosting your calendars in the cloud.

Google Calendar

Anyone with a Google account can create, edit, and share calendars
online at http://calendar.google.com/. Google accounts are free, and
include access to a long list of other features too, including Gmail,
Google Drive, Google+, and so on. Anyone who wants to use Google
products with their own domain name can sign up for a Google Apps
account (http://www.google.com/enterprise/apps/business/)—free
for individuals and groups of up to ten users but also available in paid
varieties with additional features for businesses and larger groups.

Google Calendar was available only via the Web at first; client access
via CalDAV was a later addition. By the time that happened, Google
had already made certain decisions about what could and could not
be done with calendars, and those limitations are reflected in its
(somewhat outdated) CalDAV implementation too. For example:

* Google lets you add tasks (a.k.a. reminders or to dos) on its
Web site, but these are not accessible to clients such as Apple’s
Reminders app and BusyCal.

* Google Calendar doesn’t support push updates over CalDAV.

* Some actions (such as creating or sharing calendars) that can be
performed within BusyCal or the Calendar app for iCloud calendars
require a trip to the Google Calendar Web site to accomplish for
Google calendars.

» Even though there’s an experimental Google Calendar Labs setting
whereby you can enable attachments to events, these attachments
don’t sync over CalDAV, and neither BusyCal nor the Calendar app
will let you attach a file to an event in a Google calendar.

Google also distinguishes between your primary calendar—the one
it creates for you by default—and secondary calendars (additional
calendars you create yourself).
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Secondary calendars have certain restrictions:

 Although BusyCal can display both primary and secondary
calendars without any extra steps, the Calendar app in OS X
requires a visit to the Delegation view of the Accounts preference
pane (see Work with Delegation, ahead).

* To add secondary calendars to the Calendar app in iOS, you must
follow an odd procedure that involves going to a special Web page
on each device and choosing which calendars you want that device
to be able to access. (For details, go to http://support.google.com/
calendar/bin/answer.py?hl=en&answer=151674 and read the
information under “Sync Multiple Calendars.”)

» If you create a meeting on a secondary calendar (see Manage
Meetings), the Google servers will not deliver your invitations
by email; they’ll appear only on the Google Calendar Web site.

Those issues aside, Google Calendar is widely used, reliable, and
arguably better suited for business applications than iCloud. (It’s
also the better choice for people who use neither OS X nor iOS,
but I assume most readers of this book have a Mac or i0S device.)

Office 365

Microsoft Office 365 is a subscription-based online suite that offers
users access to a variety of cloud-based services. There are currently
seven different Office 365 plans to choose from, each with its

own combination of features. For the purposes of this book, we’re
concerned only with the business plans, all of which include access
to an Exchange server (for calendar, contacts, and email) via a Web
browser or clients such as BusyCal or Outlook. See http://
office.microsoft.com/business/.

Although Office 365 uses Exchange behind the scenes, BusyCal offers
a distinct Office 365 account type to simplify setup, so you need not
concern yourself with some of the details that other (especially older)
Exchange servers require.

Other Calendar Servers

Because iCloud and Google Calendar are the dominant CalDAV
services for Mac users, those are the ones I pay the most attention

to in this book. However, in theory—and leaving aside any weird
implementation details that could affect compatibility—both BusyCal
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and Apple’s Calendar app should be able to connect to pretty much
any CalDAV server, of which there are many other choices.

If you're looking for a cloud-based service for calendar syncing (plus
contacts, perhaps), you might consider a provider such as Fruux
(https://fruux.com/, currently free but with paid accounts planned
for the future) or Yahoo Calendar (http://calendar.yahoo.com/, free).
But such services are just the beginning.

You can find a fairly long (but not exhaustive or entirely up to date)

list of CalDAYV server implementations at http://caldav.calconnect.org/
implementations/servers.html. The list includes both commercial and
open-source software, and these servers are, in turn, used by a great
many businesses and online calendar providers. For example, if you
sign up for a business account with MacServ (http://macserv.com/),
you’ll find yourself using the Kerio Connect server, which includes not
only CalDAV but also contacts and email.

Although I don’t recommend it, you could—if you were so inclined
and of a suitably geeky disposition—install one of these server apps on
a Mac of your own, to provide CalDAV services to computers on your
local network and on the Internet. If that idea tempts you, the easiest
way to run a CalDAV server is to buy OS X Server, a $19.99 add-on

to OS X. Among many other features, it includes Calendar Server
(formerly called iCal Server), which is yet another implementation

of CalDAV. But be warned: running your own CalDAYV server is not a
trivial undertaking, and in almost every case you’ll be much happier
using a free or paid CalDAV server run by someone else.

Likewise, Office 365 is just one of many Exchange server providers.

If you'd like to use Exchange but not Office 365, try a Web search

for “hosted Exchange provider.” You’ll find options such as Intermedia
(http://www.intermedia.net/), Mail2Web (http://mailzaweb.com/
business-email/), Rackspace (http://www.rackspace.com/email-
hosting/hosted-exchange/), and hundreds of others. You can also
install your own Exchange Server if you have a suitable hardware

and network setup (Exchange Server runs only on Windows), but it’s
expensive and nontrivial to set up and manage.
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Connect to a Cloud-based Calendar Server

Once you know which service you want to use, connecting requires
little more than entering your username and password, and in some
cases a server address. Since the process is largely self-explanatory, I
provide just an overview here, with links to where you can learn more.

Note: Since the iOS Calendar app uses a much different approach,
I mention it separately ahead—see Connect to a Cloud-based Server
with the iOS Calendar App.

Connect to a Cloud-based Server from BusyCal

On a Mac running BusyCal 2, you’ll most likely find that any cloud-
based accounts you previously configured (either in the Mail, Contacts
& Calendars pane of System Preferences or in an earlier version of
BusyCal) are set up automatically, and at most require you to reenter
your password.

However, if you need to set up a new account, do the following:
1. In BusyCal, choose BusyCal > Preferences and click Accounts.
2. Click the plus + button at the bottom.

3. In the dialog that appears, enter your username (which is usually
your email address) and password, choose the type of server (such
as iCloud, Google, or Exchange) from the Server Type pop-up menu,
and click OK.

4. In BusyCal’s Accounts preference pane, you can optionally change
any of the default settings, which vary somewhat by the type of
server you're connecting to. The one you're most likely to change
is the Refresh Calendars setting, which specifies how often BusyCal
checks for updates (Push is an option on this menu only for servers
that support push updates.)

Tip: Because scheduled updates are necessary only for incoming
changes, not for updating the server with changes you make locally,
a refresh rate of every 15 minutes is nearly always sufficient.
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5. Close the Preferences window. Then, in BusyCal’s main window,
look in the sidebar for the newly added account. Check or uncheck
each calendar in the account (of which there may be one or several)
to show or hide it.

6. Right-click (or Control-click) the calendar name in the sidebar
to display a pop-up menu with additional options, such as a Get
Info command (for changing the name and various other settings)
and a Color submenu (for changing the color of calendar entries).

To learn about the many other ways you can customize calendars in
BusyCal, refer to the BusyCal help at http://www.busymac.com/help/.

Connect to a Cloud-based Server with the iOS
Calendar App

There’s no BusyCal app for i0S, but that’s no problem—you can use the
built-in Calendar and Reminders apps on your iOS device to connect
to all the cloud-based calendars you access on your Mac with BusyCal.

All accounts are handled centrally in the Settings app. Tap Settings >
Mail, Contacts, Calendars; then, tap Add Account, tap an account type,
and enter your credentials. The exact steps depend on the type of
account you’re using. For specific instructions on connecting an iOS
device to iCloud, Google Calendar, or Exchange, see http://
www.busymac.com/tc/ios.html.
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Share Calendars with
Other People

Sharing a calendar from iCloud, Google Calendar, or Exchange
enables a family member, friend, or colleague to see everything
on the calendar—and optionally gives them the power to make

additions, changes, or deletions.

In this chapter, I explain the ins and outs of calendar sharing—how
it works and how to share your calendars from BusyCal, the iCloud
Web site, the Google Calendar Web site, or the Office 365 Web site.

I also briefly discuss delegation, and why you might need to know
about this slightly different approach to calendar sharing. And I've
included a sidebar about publishing and subscribing to read-only
public calendars (such as holidays and sporting events).

Learn How Calendar Sharing Works

At the risk of repeating the obvious, syncing—covered in the previous
chapter, Sync Calendars with the Cloud—is what you do to ensure that
your own cloud-based calendars are the same on all your own personal
devices. Sharing, on the other hand, is what you do to enable other
people to see (and, if you wish, edit) those calendars; I cover that in
this chapter for syncing via the cloud, and in the next chapter (Sync
Calendars over a Local Network) for syncing on a local network. Any
given calendar can be both synced and shared.

Because cloud-based calendars live on a server, you must, by
definition, sync them if you want to use them in an app like BusyCal
or Apple’s Calendar—by setting up the calendar account on your Mac
or i0S device, you're instructing the device to sync with the online
calendar. Sharing is an optional extra step.
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Meet and share: Meetings are another form of sharing; when

you invite people to a meeting (see Manage Meetings, two chapters
ahead), you are in effect sharing just one event from your calendar
with them. Your calendar need not be shared in order to invite
someone to a meeting. And, even if you have shared a calendar with
someone, you might want to invite them to a meeting that’s already
on your calendar—the fact that you have an event scheduled for such-
and-such a time doesn’t necessarily imply that they should attend!

Basically, if you want someone to be able to see everything on your
cloud-based calendar—whether or not you also want them to have
write access or attend your meetings—you want to share your calendar.

You can share an iCloud or Exchange calendar (including Office 365)
from within BusyCal or Apple’s Calendar app; to share a Google
calendar, you must make a trip to the Google Calendar Web site. (For
other CalDAV calendars, the way sharing works depends on the server;
see Work with Delegation for more information.) Regardless of where
you set up sharing, the server—not your calendar app—is responsible
for making it available to other people. Even if all your Macs and i0S
devices are turned off, your calendars remain available to everyone
you’ve shared them with, and they can all sync the shared calendars
with all of their Macs and iOS devices.

You have two main choices to make when sharing calendars:

* Public or private? A public calendar is one anyone in the world
can connect to—as long as they know the calendar’s address.
Public calendars are always read-only.

Sharing an iCloud or Exchange calendar publicly doesn’t add the
calendar to a public list or directory that someone might stumble
across; it simply results in the creation of a URL on a server
somewhere that anyone who knows it can enter into their own
calendar client—it’s still semi-private in the sense that it’s protected
by obscurity.

However, the same is not true of Google calendars you share
publicly; by default Google includes such calendars in public Web
and Calendar search results. (You can opt to keep calendar details
private and reveal only your free/busy availability, but that mostly
defeats the purpose of sharing a calendar.) For some interesting
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background information on public calendar sharing, read the
sidebar Public Calendar Subscriptions, ahead.

A private calendar is available only to the specific people you invite,
and you can give each person read-only or read-write access. To
access your private calendar, someone must log in to their (iCloud
or Google) account using the email address you entered when
sharing the calendar with them.

In and out: You can share a calendar as both public and private,
thus giving some people read-write access (see the next point)
while enabling anyone to view the events.

* Read-only or read-write? You can optionally give write access
to any or all of the people you share a calendar with privately; when
you do, they can add, modify, and delete events—and optionally,
in the case of Google Calendar, change the set of people with whom
it’s shared. About the only thing they can’t do is delete the calendar.
Exchange calendars offer three levels of access: in addition to read-
write (Editor) and read-only (Reviewer) roles, there’s a Contributor
role, which means the person can create and read events, but can’t
edit or delete existing events.

When you share a calendar, nothing changes for you as the calendar’s
owner—the only difference you may notice is a small . icon next to
the calendar’s name in BusyCal or the Calendar app indicating that it’s
shared. Sharing doesn’t affect syncing, although you may (depending
on your settings) see notifications when other people make changes to
your calendar. Similarly, if you connect to a calendar someone else has
shared with you, it behaves in every way like a calendar of your own
(including syncing to any and all devices on which you’ve set up the
relevant account)—the only difference is a read-only . icon in BusyCal
if the person sharing the calendar hasn’t given you write access.

With that background out of the way, I want to say a few words about
the specific features and limitations of calendar sharing in iCloud,
Google Calendar, and Office 365 and provide a brief outline of how to
share calendars in each service.
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Share iCloud Calendars

Sharing calendars in iCloud is considerably easier than sharing
them with Google Calendar or any other CalDAV server. The process
is particularly smooth and seamless if the people you're sharing with
use 10.8 Mountain Lion or later on a Mac, or iOS 5 or later on an iOS
device. However, you should be aware of two limitations:

» Although anyone can connect to a publicly shared iCloud calendar,
the people with whom you share your calendars privately must have
an iCloud account. If you share a calendar privately with someone
who doesn’t have an iCloud account, they’ll be invited to set one up,
after which they can connect to your calendar.

» Regular calendars can be shared either publicly or privately, but
task (reminder) lists can be shared only privately.

You can share iCloud calendars in the following ways:

* From within BusyCal: Double-click a calendar name in the
sidebar (or select it and choose Edit > Get Info). Then check the
Share Calendar box and set the options you want to use (Figure 1).
For full instructions, see http://www.busymac.com/tc/caldav-
sharing.html.

 From within Calendar: In Calendar on a Mac, select a calendar,
choose Edit > Sharing Settings, and follow the prompts; for more
detail, see http://support.apple.com/kb/PH11552. In Calendar
on an iOS device, tap the Calendars button, tap the blue arrow ©
button next to the name of the calendar you want to share, tap Add
Person, and follow the prompts.
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CalDAV Calendar Info

4»

Name: ‘You Can Call Me Cal

Description:

[YI Events affect availability
|| Holiday calendar
Subscribe Options

Ignore: | | Alarms
|| Attachments
To Dos

Sharing Options
[9] Share calendar

() Share read-only with everyone
URL: Available when published
(») Share with the following people:

Email Allow Write

ace@tidbits.com (Adam Engst) n

| Unsubscribe | | Cancel | [ OK |

Figure 1: Share iCloud calendars within BusyCal here.

From the iCloud Web site: Log in to your account on
icloud.com, click the Calendar app, click the sharing - icon

next to a calendar, and follow the prompts (Figure 2). For details,
see http://support.apple.com/kb/PH2690.
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Cancel OK
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Figure 2: This popover shows controls for sharing a calendar from
the iCloud Web site.

When you share a calendar publicly, you get a URL that you can post
or send directly to anyone you want to be able to view the calendar.
When you share a calendar privately, those with whom you’ve shared
it receive an email message with the instructions for subscribing—
generally a simple matter of clicking a single link. Both BusyCal and
the Calendar app also display an Inbox |2t | icon in the toolbar that
shows updates to shared calendars and other notifications.

Share Google Calendars

Google calendars have more sharing options than iCloud calendars.
For example, when sharing a calendar privately, you're not limited
to offering read-only or read-write access. You have four choices:
See Only Free/Busy; See All Event Details (equivalent to read-only
access); Make Changes to Events (equivalent to read-write access);
and Make Changes AND Manage Sharing. And if you have a Google
Apps account, when sharing a calendar publicly, you can check a box
to give everyone in your organization access to it at once.

On the other hand, there’s no way to share Google calendars or adjust
sharing settings from within BusyCal or the Calendar app; you must
log in to your account on the Google site and make any desired changes
there. And, as with iCloud, although anyone can load a publicly shared
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calendar without needing an account, anyone who wants to access your
privately shared calendar must have a Google account.

To share a Google calendar, log in at http://calendar.google.com/,
click the menu ~ button next to a calendar name, and choose Share
This Calendar from the pop-up menu (Figure 3).

4am
+~ My calendars v
Joe—Google Sam
Example Calendar [+] Aam
Tasks Display only this Calendar
Hide this calendar from the list
» Other calendars Calendar settings

Create event on this calendar
Share this Calendar

&

Notifications

1111
]
|
]

Choose custom color

Figure 3: Choose this command to display the settings page for
sharing your Google calendar.

Then do the following:

» To share the calendar publicly, select Make This Calendar Public,
click Save, and click Yes to confirm.

* To share the calendar privately, enter an email address in the
Person column, choose the permissions you want to grant that
person, and click Add Person. Then click Save. For more info,
see http://support.google.com/calendar/bin/answer.py?
hl=en&answer=37082.
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As with iCloud calendars, when you share a calendar publicly, you get a
URL that you can circulate as you wish. (To see the calendar’s address,
click the menu~ button next to the calendar’s name and choose
Calendar Settings from the pop-up menu. Then click the green ICAL
button in the Calendar Address section near the bottom of the page, as
shown in Figure 4.) When you share a calendar privately, it appears
automatically in the other users’ Google Calendar lists; everyone with
whom you’ve shared it also receives an email message containing a link
they can click to connect to the calendar.

Calendar Address: XMI. LAY (Calendar ID: @gmail.com)

Learn more ) This is theaddress for your calendar. No one can use this link unless you have made your
Change sharing settings calendar public.

Private Address: BT TN Reset Private URLs

Learn more This is the private address for this calendar. Don't share this address with others unless you

want them to see all the events on this calendar.

Figure 4: Click the ICAL button circled above to display the public
address for a shared Google calendar in iCalendar format.

Share Office 365 (Exchange) Calendars

Sharing Office 365 calendars is much like sharing iCloud calendars (at
least within BusyCal). As I mentioned in Learn How Calendar Sharing
Works, one difference is that you have not only Read Only and Read &
Write privileges to choose from, but also Read & Create (which
prevents the user from editing or deleting events).

Tip: Since Office 365 uses Exchange for calendars, all these
instructions, with the exception of the final bullet point, apply to
other Exchange servers as well.

You can share Office 365 calendars in the following ways:

* From within BusyCal: Double-click a calendar name in the
sidebar (or select it and choose Edit > Get Info) to display the
dialog shown in Figure 5.
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Exchange Calendar Info

Name: Calendar |l ;|

Description:

v/ Events affect availability
Holiday calendar
Subscribe Options
Ignore: | | Alarms
| Attachments
Sharing Options
Share calendar with the following people:

Email Access

ace@tidbits.com Read & Write

' Unsubscribe | . Cancel | | OK |

Figure 5: Share Exchange calendars within BusyCal here.

Then, in the Sharing Options section, click the plus' + button,
enter another person’s email address, and choose the desired level
of access from the Access pop-up menu:

» Availability: User can view your Free/Busy time in the
Availability Panel (see Schedule a Meeting with Exchange) but
can’t view the details of the events. This option is available only
for your primary calendar.
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» Availability, Title, Location: User can view your event titles
and locations in the Availability Viewer. This option is available
only for your primary calendar.

» Read Only: User can view existing events but can’t create or
edit events.

» Read & Create: User can view existing events and create new
events, but can’t edit existing events.

» Read & Write: User can view and edit existing events and
create new events.

» Delegate: Same as Read & Write, plus user can create and
respond to email meeting requests on your behalf. (See Work
with Delegation for further details.)

For full instructions, see https://support.busymac.com/help/
25995-sharing-calendars-with-others-through-exchange.

From within Calendar: In Calendar on a Mac, you can share an
entire Exchange calendar account but not an individual calendar;
for details, see http://support.apple.com/kb/PH11547. (Calendar
on an iOS device offers no way to share an Exchange calendar.)

From the Office 365 Web site: To share a calendar privately,
log in to your account on at https://outlook.office365.com/ and
click Calendar. Then right-click (or Control-click) a calendar in

the sidebar and choose Share Calendar from the contextual menu

to display the sharing controls (Figure 6). Enter one or more email
addresses in the Share With field and press Tab. For each person,
choose the desired level of access. (For more on the Delegate option,
available only to those within your organization, see Work with
Delegation, ahead.) Click Send. Read http://office.microsoft.com/
client/15/help/preview?Assetld=HA103842904 for further details.

To share a calendar publicly, right-click (or Control-click) the
calendar name and choose Permissions from the contextual menu.
Choose the level of detail you want to publish from the pop-up
menu in the Public Calendar section. Then right-click the Subscribe
to Calendar link to copy the link to the calendar’s .ics file (see the
sidebar Public Calendar Subscriptions, next), which you can then
share with other people.
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Figure 6: You can share calendars on the Office 365 Web site.

Public Calendar Subscriptions

When you share a calendar publicly (with iCloud, Google Calendar, or
Office 365), you create a file in iCalendar (.ics) format that contains

all your calendar data; the file is then published in a read-only
form via WebDAV at a URL that the server supplies to you. (This is

a bit different from privately shared calendars, in which each person

viewing the calendar uses the more interactive CalDAV protocol.)
People who want to view the calendar then subscribe to it in their
calendar client. (Exchange servers support a similar feature, but
restricted to users within your organization; see Subscribe to
Exchange Public Calendars, ahead.)

In BusyCal, you subscribe to a public calendar by choosing File >
New Calendar Subscription and filling in the calendar’s URL (and,
sometimes, other details) in the dialog that appears.

Apple, Google, Yahoo, and other calendar providers host public
calendars of general interest, such as holidays, sports schedules,
and movie releases. You can find a list of popular public calendars
at http://www.busymac.com/webdav.html, and over 4,000 user-
maintained calendars at http://icalshare.com/calendars.
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Work with Delegation

Most CalDAYV servers, as well as Exchange servers (but not iCloud),
use the term delegation to refer to calendar sharing in which you grant
others the power to make changes to your calendar. The people who
have such access are called delegates (think of the busy executive
delegating her schedule to her secretary). Other than the fact that
“delegation” sounds more complicated and business-y than “sharing,”
it’s more or less the same thing—delegation is simply an older model
for sharing calendars.

If you're syncing with a CalDAV server that uses delegation for sharing
and you want to grant someone (a delegate) access to your calendars,
do the following:

1. In BusyCal, choose BusyCal > Preferences and click Accounts.

2. Select the CalDAYV server, click Delegation, and then click the Edit
button.

3. Click the plus + button. Enter the name of another user who’s
connected to the same CalDAV server, and then select the checkbox
if you want to grant them write access to the calendar. Click OK;
repeat this step to add more delegates.

For Exchange servers, BusyCal lets you share calendars with a delegate
(see Share Office 365 (Exchange) Calendars) and add calendars for
which someone else has delegated access to you. To add a delegated
calendar:

1. In BusyCal, choose BusyCal > Preferences and click Accounts.
2. Select the Exchange server and click Sharing.

3. Click the plus + button. Enter the name of the user who’s
delegating access to you (this user must be connected to the
same Exchange server).

The delegated calendars appear in BusyCal’s sidebar.

All or nothing: When you make someone a delegate, that person
has access to all the calendars in your account on that server. By
contrast, under the sharing model that iCloud, Google Calendar,
and Exchange use, you can restrict access to individual calendars.
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Subscribe to Exchange Public Calendars

Exchange supports public calendars, created by your network
administrator, that can be shared with all users in an organization.

To subscribe to a public calendar:

1. Choose BusyCal > Preferences > Accounts, select your Exchange
Account in the list on the left, click Sharing, then click the Public
Calendars button.

2. In the browser that appears, navigate to the public folder containing
the public calendar you want to subscribe to. Select the calendar
and click Subscribe.

The public calendar will appear in the left sidebar. To unsubscribe
from a public calendar, right-click (or Control-click) on it in the left
sidebar and choose Unsubscribe.
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Share Calendars over a
Local Network

Despite the many advantages of syncing your calendars with

a cloud-based service and then sharing them (if you wish) with
specific people, there are cases in which you might want to cut
the cloud out of the mix entirely and share calendar data directly
with other computers over your local network. In this situation,
the word “sharing” has a somewhat different sense; it’s more a
matter of publishing and subscribing.

Although I'll try in this chapter to convince you that local-area
network (LAN) sharing is seldom the best idea, BusyCal does it
extremely well, and using this capability may enable you to solve
certain problems with a minimum of fuss.

Understand the Limitations of LAN Sharing

LAN sharing in BusyCal is largely a remnant of the days before services
such as iCloud and Google offered free cloud-based calendar syncing.
Although MobileMe offered a way to sync one’s own calendars among
several Macs, there weren’t any great options for sharing calendars
among different users on the same network. BusyCal’s predecessor,
BusySync, filled that need admirably, and BusyCal inherited the same
capability. My wife and I used this capability successfully for years to
share each other’s calendars, which we then synced independently to
our (pre-iPhone) mobile devices.

Hello, Bonjour! BusyCal’s LAN sharing uses an OS X technology
called Bonjour, which is a type of zero-configuration networking.
That means computers on your network can see each other and figure
out what network services are available without your having to know
any Mac’s network address or enter any settings.

LAN sharing in BusyCal still works as well as it ever did—in fact, better
than ever—but it solves a problem most people no longer have, since
sharing cloud-based calendars is now free, easy, and ubiquitous.
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Furthermore, compared to sharing cloud-based calendars, LAN
sharing has several important limitations:

In LAN sharing, your local Mac—not a server somewhere—holds the
master copy of your calendar. That in itself isn’t a disadvantage, but
in BusyCal 2, that local calendar doesn’t connect to anything except
other copies of BusyCal. It doesn’t sync with third-party apps on
your Mac (such as Microsoft Entourage or Outlook), and crucially, it
doesn’t sync with Apple’s Calendar app either.

That, in turn, means you cannot sync your local calendars (or
calendars others have shared with you over the LAN) with your
10S devices. At all. Nor can you republish your local or LAN-shared
calendars to the cloud (or vice-versa); see the sidebar Farewell to
Republishing.

You can optionally set a password for read-only access, read-write
access, or both—but these passwords apply to everyone who
connects to the calendar. You don’t have the user-level control over
permissions that you do when sharing cloud-based servers.

Everyone else who accesses your calendars via LAN sharing must be
using BusyCal on a Mac—other clients and platforms are right out.

Calendars stay in sync only when devices are connected to your
network; if someone takes a laptop out of the building, for example,
calendar changes won’t show up until the device reappears on your
network. (Depending on your network hardware and configuration,
it may be possible to enable remote access, but you must make
your Mac publicly accessible over the Internet; you’ll also require
knowledge of port forwarding and other advanced router
configuration settings.)

And that, in a nutshell, is why LAN sharing probably is not for you.

However, you might be an exception to this rule! One advantage LAN
sharing has over sharing cloud-based calendars is that you control all
your own data. If your calendars contain sensitive information, you
need never worry that they’re in the hands of some big corporation
that could suffer a security breach, network outage, or goodness knows
what else. Your data is as secure as your network, and you can take
whatever steps you like—firewalls, VPNs, whatever—to ensure that

no one outside your network can see your calendars, even by accident.
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And, let’s not forget that many Mac users don’t have any iOS devices
and seldom if ever move their Macs. If your family or business needs
access to shared calendars only on Macs running BusyCal and only
when connected to your network, LAN sharing is a great idea because
it’s simple to set up and it avoids having to mess with iCloud or Google
accounts.

Set Up LAN Sharing with BusyCal

As I mentioned earlier, LAN sharing with BusyCal is different from
both cloud syncing and sharing of cloud-based calendars; it’s sort

of a hybrid of the two. You begin with a local (“On My Mac”) calendar
that you publish with a few clicks, making it available to other copies
of BusyCal on your network. Then, in the other copies of BusyCal,
you subscribe to the published calendar—which consists merely of
checking a box and (if applicable) entering a password.

For complete instructions on publishing BusyCal calendars over a LAN
and subscribing to them, see http://www.busymac.com/tc/busycal-
lan.html.
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Manage Meetings

If you're organizing a meeting, simply popping an event on a
calendar—even one that’s shared with the people you're inviting—
may not be enough. You may want to invite other participants, track
whether they’ve accepted or declined, and have a means of sending
out updates or cancellations automatically if the event data changes.
All that is part of what CalDAV and Exchange offer, and therefore
it’s available to you in BusyCal and Apple’s Calendar app.

Unfortunately, when it comes to calendar apps and services,
meetings turn out to be surprisingly tricky because they involve
many variables, of which any participant can control only a few.
As a result, problems like missing invitations, missing responses,
and invitations sent from the wrong account are all too common.
In this chapter, I explain why meetings are such a challenge for
calendar apps, how they’re supposed to work, and how to increase
the chances that they will work that way for you!

Understand How Meetings Are Supposed to
Work (and Why They Often Don’t)

When it comes to scheduling meetings within an organization,
Exchange offers a darn good experience. The meeting organizer can
see everyone’s availability in advance and can count on meeting
invitations and responses being sent and received. In general, for both
organizers and attendees, meeting scheduling just works. Although
this seamless operation used to require that everyone use Outlook,
BusyCal 2.5’s Exchange support includes viewing availability, making
BusyCal an equally good calendar client.

But Microsoft Exchange Server is expensive, uses proprietary
protocols, requires considerable expertise to manage, and doesn’t run
on OS X. So most people and organizations that use Macs gravitate
toward less-expensive options that use open standards such as
CalDAV. Unfortunately, the freedom for each person to use different
clients (or even different calendar servers) also has the consequence
of introducing many variables that could cause problems.
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If you and everyone who will be attending your meetings use

BusyCal, and you all connect to the same (iCloud, Google Calendar,
Office 365, Exchange, or CalDAV) server, your experience can be
smooth too. However, if you don’t know and can’t control what
software and services the other participants are using, all bets are

off. Differing calendar clients, email clients, and software settings

can disrupt meeting invitations and responses. And, when participants
use different calendar servers, there’s no guarantee they’ll all see the
same thing.

With that disclaimer aside, let me describe how meeting scheduling
should work. I'll give two examples. Both assume everyone involved
uses BusyCal, but the first illustrates how scheduling should work
when all participants use iCloud and the second illustrates the same
thing with Exchange (although the process is similar for users of
Google Calendar and other CalDAV calendars).

Schedule a Meeting with iCloud

To organize a meeting, you start by creating an ordinary event on
one of your iCloud calendars in BusyCal. Then you enter the email
addresses for one or more people you want to invite in the Attendees
field, and click Send Invitation.

If an invitee has an iCloud address (ending in @icloud.com,
@me.com, or @mac.com)—and uses the default iCloud setting to
receive in-app notifications (see https://support.busymac.com/help/
11000-meetings#icloud)—the invitation will be delivered directly

to her BusyCal or Calendar inbox, from where she can respond with
“Accept,” “Decline,” or “Maybe.” However, if a recipient has a non-
iCloud address or has opted to receive invitations by email, the
calendar server sends that person an email message containing details
of the invite and buttons for “Accept,” “Decline,” and “Maybe. (It’s

in this email process that things most often go out of whack.) In any
case, when the recipient responds, you as the meeting organizer (as
well as any other attendees) can see an icon next to that attendee’s
name indicating her status.

The attendee who has just replied by clicking a button in an email
message is taken to a Web page with event details. If she wants

to add the event to her own calendar, she clicks a link on that page
to download a .ics file, which opens in BusyCal. (The same .ics file
appears in the email invitation, and can be opened from there, too.)
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BusyCal prompts her to choose which calendar the event should go
on. Once it’s in her calendar, the attendee can change her status from
within BusyCal, and can also see the status of other attendees—
accepted @, declined @, maybe ¢, or not yet replied &.

If you later modify or cancel the meeting, other participants receive
an email notification. But the event on their calendars doesn’t update
itself automatically—as before, they must open the .ics file in BusyCal
(which replaces the old event with the updated version).

Now then... what might go wrong? When and why would this process
not work the way it should? Let me give you a few examples:

» Attendees might not receive their invitations. As I mentioned,
invitations sent from iCloud to other iCloud addresses (that is,
addresses in the icloud.com, me.com, or mac.com domains) usually
arrive as they should; with other addresses, it’s hit-and-miss.

» Even if attendees receive the message, they may not respond to the
invitation by clicking Accept/Decline/Maybe.

* Attendees might not realize they must open the .ics file to put the
meeting on their own calendars, and forget about the meeting.

* The email message containing the invitation may come from an
unexpected address (see Where Meeting Invitations Come From,
ahead), leading to the message being incorrectly marked as spam
or just ignored by the recipient.

 If an attendee adds the event to a non-iCloud calendar, meeting
status changes may or may not show up correctly.

Many other things can go wrong, too. Although it’s impossible to
eliminate all possible problems, the point I want to reiterate is that

if you can be sure all attendees use BusyCal and the same server

(in this example, iCloud—but the same would be true of other calendar
servers), you'll significantly reduce the likelihood of issues. That
brings me (after a brief sidebar) to how scheduling should work with
Exchange accounts.
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Where Meeting Invitations Come From

If you invite someone to a meeting that’s stored on an iCloud
calendar, the server sends the email invitation—but not from your
address! The sender appears as Your Name <noreply@apple.com>,
which means recipients may not recognize the email as coming from
you, and rules or filters designed to accept or file email from known
senders may fail. However, your name and default iCloud address

do appear in the event description as the "meeting organizer.” That
means if you're scheduling a business meeting but keeping it on your
personal calendar, recipients will see your personal iCloud address.

On the other hand, if you invite someone to a meeting on a Google
calendar, the email does come from your default Gmail address,
which also appears as the meeting organizer. (The same goes for
Exchange.) You can change the default address for Google calendar
on the Accounts tab in Gmail’s Settings view.

In each of these cases, the server bypasses your email account
completely. The invitations will not appear in your email client’s Sent
mailbox, even if they came from your address.

For local calendars (such as those you’re sharing over a LAN), the
situation is completely different. You can choose which email address
invitations come from, and if you prefer, you can have BusyCal create
the invitations as messages in Mail but not send them automatically
(so you can verify or edit their contents first). Either way, invitations
to events on local calendars do appear in your Sent mailbox.

For best results, send meeting requests to addresses in the same
domain that hosts the calendar server. For example, if you're using
iCloud, meeting requests should be addressed to recipients’ iCloud
email address (@icloud.com, @me.com, or @mac.com), if you know
them. The same goes for Google and Exchange addresses. If you
send a meeting request to an email address that does not match your
calendar server account, meeting replies and updates may not work
properly. The failures vary depending on which service you are using
and are not specific to BusyCal.
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Schedule a Meeting with Exchange

The process begins as it does for iCloud accounts. You create an event
on one of your Exchange calendars in BusyCal. Then you enter the
email addresses for one or more people you want to invite in the
Attendees field. But when you press Tab to leave the Attendees field,
another button appears above the Send Invitation button. Click this
button, Available Meeting Times, to display the Availability Panel
(Figure 7). This window lets you see when the other participants are
available—as long as they’re on the same Exchange server—and quickly
find a time without conflicts.

Note: Each BusyCal user can specify, for any event, a status (such as
Busy or Free) by using the Show As pop-up menu.
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Figure 7: The Availability Panel, with the proposed time in brown.

Once you've selected a time, click Send Invitation. This causes the
calendar server to send that person an email message containing

a .ics file with the meeting’s details. The recipient can click that file

to add the meeting to any BusyCal calendar; once added, the event
displays buttons for “Accept,” “Decline,” and “Maybe.” When the
recipient clicks one of those buttons, you as the meeting organizer

(as well as any other attendees) can see an icon next to that attendee’s
name indicating their status (accepted @, declined @, maybe ¢, or not
yet replied @). In some cases, updating your event to show attendees’
status requires clicking a .ics file in an email response.

If you later modify or cancel the meeting, other participants receive
an email notification. But if the participants aren’t using the same
Exchange server, the event on their calendars doesn’t update itself
automatically—as before, they must open the .ics file in BusyCal
(which replaces the old event with the updated version).
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If all attendees have accounts on the same Exchange server and use
BusyCal or Outlook, this process is pretty reliable, but for those using
other calendar servers or apps, all bets are off. You won’t be able to see
their availability, you can’t count on their .ics files being handled
correctly, and you may or may not receive replies to your invitations.

Understand How the "Me” Card Is Used

In the OS X Contacts app, you should find an entry for yourself.

(Go ahead and check now—open Contacts, and then choose Card >

Go to My Card and make sure your name shows up.) That entry should
have a little silhouette - icon next to it, indicating that Contacts knows
it’s your entry, not just someone in your address book who happens

to share the same name. (If you don’t have an entry for yourself, make
one. To designate an entry as your “me” card, select it and choose

Card > Make This My Card.)

When you have meetings on your schedule, it’s important to have
a properly designated “me” card, because BusyCal uses it in the
following ways:

* When sending invitations to meetings on local calendars, BusyCal
needs to know which address to use. The Meeting Organizer Email
pop-up menu in BusyCal’s Advanced preference pane displays all
the addresses from your “me” card.

» Before you can accept or decline an incoming meeting invitation,
BusyCal must be able to match the address to which the invitation
was sent with an address on your “me” card. (Therefore, it’s a good
idea to list all your active email addresses on that card.)

* In order to edit a meeting you created (whether you created it
within BusyCal or elsewhere), BusyCal must be able to match the
address shown in the event as “meeting organizer” with one of the
addresses on your “me” card.

For further instructions: Now that you know the basics of
how meetings work, you probably want more detail about how to
manage them in BusyCal. The specifics of sending and responding
to invitations, updating meetings, and so on are all found in the
BusyCal help at http://www.busymac.com/tc/meetings.html.
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About This Book

Thank you for downloading this Take Control book. We hope that
you find it both useful and enjoyable to read. We welcome your
comments at tc-comments@tidbits.com.

Ebook Extras

You can access extras related to this ebook on the Web. Once you're
on the ebook’s Take Control Extras page, you can:

« Download any available new version of the ebook for free.

» Download various formats, including PDF, EPUB, and Mobipocket.
(Learn about reading this ebook on handheld devices at http://
www.takecontrolbooks.com/device-advice.)

* Read postings to the ebook’s blog. These may include new
information and tips, as well as links to author interviews. At the
top of the blog, you can also see any update plans for the ebook.

+ If you bought this ebook from the Take Control Web site, it has
been automatically added to your account, where you can download
it in other formats and access any future updates. However, if
you bought this ebook elsewhere, you can add it to your account
manually:

» If you already have a Take Control account, log in to your
account, and then click the “access extras...” link above.

» If you don’t have a Take Control account, first make one by
following the directions that appear when you click the “access
extras...” link above. Then, once you are logged in to your new
account, add your ebook by clicking the “access extras...” link
a second time.

Note: If you find that the device you're reading on is incompatible
with the Take Control site, contact us at tc-comments@tidbits.com.
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list of the trademarks and of the registered trademarks of Apple Inc., you can visit
http://www.apple.com/legal /trademark/appletmlist.html.
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Featured Titles

Click any book title below or visit our Web catalog to add more
ebooks to your Take Control collection!

Take Control of Apple Mail in Mountain Lion (Joe Kissell) Learn
the basics and go under the hood with Apple’s Mail application in
0OS X 10.8.

Take Control of Backing Up Your Mac (Joe Kissell): Set up a rock-
solid backup strategy so that you can restore quickly and completely,
no matter what catastrophe arises.

Take Control of CrashPlan Backups (Joe Kissell): Join backup expert
Joe Kissell as he shares real-world advice about protecting your data
with CrashPlan’s onsite, offsite, and cloud backups.

Take Control of iBooks Author (Michael E. Cohen): Plan your project,
customize a template, set up a table of contents, lay out pages, add
interactivity and glossary items, and publish your masterpiece!

Take Control of iCloud (Joe Kissell): Understand the many features,
get set up properly, and enjoy iCloud!

Take Control of iTunes 11: The FAQ (Kirk McElhearn): This FAQ-style
ebook helps you wrap iTunes around your little finger and enjoy your
media more.

Take Control of Making Music with GarageBand 11 (Jeff Tolbert):
Combine your creativity with GarageBand’s editing and mixing
techniques to compose tunes that please the ear!

Take Control of Spotlight for Finding Anything on Your Mac (Sharon
Zardetto): Whether by mouse or menu, or by typing a complex query,
you’ll learn how to find your files, contacts, images, and much more.

Take Control of the Mac Command Line with Terminal (Joe Kissell):
Learn the basics of the Unix command line that underlies Mac OS X,
and get comfortable and confident when working in Terminal.

Take Control of Your 8o2.11n AirPort Network (Glenn Fleishman):
Make your AirPort network fly—get help with buying the best gear, set
up, security, and more.
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